NEW FEATURES
IN THE
CARRIER
HOURLY ANALYSIS PROGRAM v4.91

Carrier Software Systems
Carrier Corporation
Syracuse, New York

rev April 29, 2015

Copyright © 2015 Carrier Corporation, All Rights Reserved
Table of Contents

Summary List of Enhancements in HAP v4.91 ................................................................. 3
  Miscellaneous Features ............................................................................................... 3
  Bug Fixes ...................................................................................................................... 3
Report Enhancements .................................................................................................... 4
Printing .......................................................................................................................... 5
Documentation ............................................................................................................... 5
Miscellaneous Features ............................................................................................... 6
Fixed Bugs ..................................................................................................................... 7
Summary List of Enhancements in HAP v4.91

This document describes enhancements in the Carrier Hourly Analysis Program (HAP) v4.91, released in May, 2015. It is intended for new users and those upgrading from HAP v4.90.

A summary list of enhancements is provided here. Sections below describe the changes in greater detail.

Report Enhancements

a. Revised the LEED 2009 EA Credit 1 Summary Report to include data for LEED template Table 1.4.2A (Envelope and Glazing Data).

b. Revised the Zone Sizing Summary report to group data more effectively for different equipment selection applications.

c. Revised the Air System Sizing Summary report to clarify content for dedicated outdoor air system (DOAS) applications.

d. Revised the Cooling Plant Sizing Summary to include sizing information for a dedicated heat recovery chiller used in a heat recovery plant.

Printing

a. Revised printing workflow throughout the program to give users more control over printing options and standardize how those options are presented.

Documentation


b. Added a template project archive containing ASHRAE 90.1-2010 constructions, ASHRAE 90.1-2010 Appendix G baseline system types, and ASHRAE default schedules.

c. Updated Help Menu options to link to Carrier’s new commercial products website.

Miscellaneous Features

a. Added the ability to specify a custom prefix when duplicating a building with spaces and equipment.

Bug Fixes

a. Corrected 15 problems reported in earlier versions of HAP
Report Enhancements

a. LEED 2009 EA Credit 1 Summary Report

Added a new section modeled on Table 1.4.2A (Envelope and Glazing Data) from the LEED online template. This section contains two tables. The first table reports gross wall area and glazing areas for each of the principal building exposures (N, NNE, NE, ENE, etc...), both for the Baseline 0-Degree building and the Proposed Building. The second table reports total roof and skylight areas for the same buildings. The program automatically processes all spaces in each building to compile data by orientation, and grand totals for the whole building. This data is organized in a format similar to that of the LEED online template so it can be easily transcribed into the template.

This addition was requested by users due both to the LEED requirement that this data be submitted, and the labor required to compile the data manually.

This table was also added to the LEED NC 2.2 Credit 1 Summary Report.

b. Zone Sizing Summary

Reorganized the content of this report to group data for equipment selection of air terminals and terminal equipment together at the start of the report. This was done in response to user feedback. It makes the report more effective to use and easier to understand.

For central systems (e.g., VAV, constant volume) the first table in the report contains maximum and minimum airflow, reheat coil capacity, fan powered mixing box airflow and capacity data for supplemental heating units for each zone. Reference information about the zone peak sensible cooling and heating loads has been moved to the second table in the report. Space peak sensible loads and airflows are found in a final table.

For terminal systems (e.g., fan coils, WSHPs) the first two tables in the report contain design airflow, cooling capacity, cooling coil inlet and outlet conditions, heating capacity, heating coil inlet and outlet conditions, fan selection data, and ventilation airflow requirements. Reference information about zone peak sensible cooling and heating loads is moved to the third table in the report. Space peak sensible loads and airflows are found in a final table.

c. Air System Sizing Summary

Revised the title of this report to “Common Ventilation Unit Sizing Summary” when this report is generated for a terminal type system (e.g., fan coils, WSHPs, VRF, etc...). Previously, use of the title “Air System Sizing Summary” caused confusion about the content of this report. This change was designed to clarify content and eliminate such confusion. For terminal systems the report contains sizing information for the coils and fans in the common ventilation unit, also known as a dedicated outdoor air system (DOAS) air handler.

d. Cooling Plant Sizing Summary

For heat recovery plants using a dedicated heat recovery chiller (DHRC), the capacity of the DHRC was added to this report. Because the DHRC is sized during a simulation run, this item will only appear on the sizing report after the plant simulation has been run.
Printing

Upgraded the printing workflow throughout the program to provide more control over printing options and to standardize how those options are presented. This was done in response to user requests.

Specific changes include:

a. The standard Windows printer selection window will appear each time you print, similar to behavior in other software. This allows you to select a printer type and modify properties such as single sided / double-sided, black&white/color, etc.

b. A Printer Setup option was added to the Reports Menu on the main HAP window to allow you to select printer type and printer options at the start of a HAP session, or at any point thereafter.

c. Your selection of printer type and printer options will be retained for the duration of your HAP session, or until you change them.

Documentation

a. Documentation Menu

Added a new Documentation menu to the HAP main window. Options on this menu allow the display of electronic documentation including the HAP Quick Reference Guide, the example problem reference results document, documents describing HAP compliance with industry standards, and a tutorial on using HAP for LEED Energy and Atmosphere Credit 1. The HAP Quick Reference Guide option was moved from the Help menu. The other documents were formerly found on the Carrier website.

b. Help Menu Web Links

Items on the Help Menu which link to pages on the Carrier website were updated to use the new web addresses for these pages on Carrier’s newly introduced commercial products website.

c. ASHRAE 90.1-2010 Template Project

Added a template project containing ASHRAE 90.1-2010 wall, roof and window prescriptive constructions, ASHRAE 90.1-2010 Appendix G baseline HVAC systems. and ASHRAE default schedules. This project archive is installed in the Archives folder.

Template projects are useful time saver when starting new projects. After installing HAP v4.91, first retrieve and save this project on your computer. Subsequently you can use the Import Project Data option on the Project Menu to import constructions, systems and/or schedules into your projects to save time recreating this data yourself.

Note that HAP v4.91 continues to install ASHRAE 90.1-2007 template projects containing similar data compliant with the 90.1-2007.
Miscellaneous Features

a. Duplicate Building (with Spaces and Equipment)

Modified this option to allow a custom prefix to be specified. Previously all data copied with this option would have the prefix [B000] for a baseline building or [P] for a proposed building, according to user selection. A third option has been added to allow you to specify a customized prefix that will be used for all data that is duplicated. This is helpful when using the Duplicate feature for applications other than LEED projects.


Fixed Bugs

This section summarizes problems which were corrected in HAP v4.91.

a. **Air Systems** – After creating and saving an air system, it did not appear in the systems list on the main screen and therefore could not be edited or calculated. This error only occurred when energy analysis features were turned off in HAP, and in the System Design Load program. In SDL this problem had been fixed shortly after release of v4.90 and was available for download beginning in January 2015. v4.91 also contains the fix.

b. **Air System Design Calculations** – When performing design calculations for an air system in which ventilation calculations were performed per ASHRAE Standard 62.1-2010, and one or more spaces specified outdoor air requirement in terms of CFM (L/s) or “% of supply air”, the ventilation sizing results were incorrect. CFM (L/s) and “% of supply air” specifications are outside the scope of Standard 62.1 and the program should display an error message to notify the user data must be corrected before calculations can be performed. The program handled this properly for 62.1-2004 and 62.1-2007, but not for 62.1-2010.

c. **Plant Simulation I** – For very specific conditions the condenser water pump energy use for a chiller plant was incorrect. This error only occurred for a chiller plant which used a shared cooling tower and the plant control “Sequenced with Part Load Chiller: High and Low Loads”.

d. **Plant Simulation II** – When simulating a hot water plant created in Equipment Wizard which used an air to water heat pump, the simulation halted and displayed an error cannot find tower record in database for record #0. As a result the simulation could not be completed.

e. **Utility Rate Wizard I** – After defining a detailed electric rate with time of day pricing, the next time the data was edited the time of day pricing table would appear as empty in certain specific situations. Input data had been saved properly but was not displayed on the input screen.

f. **Utility Rate Wizard II** – For a detailed electric rate, the Demand Charge Steps and Demand Charge pricing table sections of the input sometimes contained incorrect data that did not match data entered on the input screen. The entered data was correctly saved and used in calculations. Only the display on the input report was incorrect.

g. **Building Wizard I** – Five of the ASHRAE prescriptive wall and roof assemblies offered in Building Wizard had U-values that deviated slightly from the ASHRAE 90.1-2010 required values.

h. **Building Wizard II** – The overall weights for wall and roof assemblies offered in the Building Wizard were incorrectly listed as 10 lb/sqft (48.82 kg/sqm). This was a cosmetic error which only affected display of data on the screen and on reports. It did not affect wall or roof load calculations.

i. **Equipment Wizard I** – In specific circumstances when defining a changeover plant, the list of chiller types was incorrect.

j. **Equipment Wizard II** – When launching the Equipment Wizard, a message *Error 76: Path not found: Wizards\EW_AirSys_Base_05.2.gif* occurred. This error occurred on a very limited number of computers.
k. **ASHRAE 90.1-2007 Template Archives** – For ASHRAE baseline system types 7 and 8 the minimum primary airflow for the parallel fan powered mixing box terminals was incorrectly set to 50% instead of 30%.

l. **Main Window I** – Under special conditions the right hand panel in the HAP main window was blank. This only occurred in certain situations using the “list view” option for the right hand panel.

m. **Main Window II** – After editing a cooling tower and then exiting the program or opening a different project, HAP did not display a warning message that the project needed to be saved.

n. **Main Window III** – If a library item (schedules, walls, roofs, windows, doors, shades, chillers, towers, boilers, electric rates or fuel rates) was entered having a name that begins with one or more space characters, the name would not be saved. For example in a schedule the entered name would be replaced with “Schedule 1”.

c. **Buildling Simulation** – When generating the LEED EA Credit Summary report, HAP requires that corresponding Miscellaneous Energy Use items in the four baseline buildings have exactly identical names. When names were edited so names differed only in the use of upper and lower case letters, HAP generated an error message which prevented the calculations from running. The validation rules have been relaxed so names must still match but can differ in the use of upper and lower case letters.